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Migrating SAS® IT Charge Management 
from SAS 8.2 to SAS 9.1.3 

 
Introduction 
If you are installing SAS IT Charge Management for the first time, you do not need to read this document. 
 
This document explains how to migrate your SAS IT Charge Management Release 2.3 currently running 
under SAS 8.2 to SAS IT Charge Management Release 2.4 running under SAS 9.1.3.  
 
Please read through the instructions before acting on them, because the choices may make a difference at 
your site. 
 
SAS IT Charge Management is the new name of IT Charge Manager. You will see references to the previous 
name whenever appropriate in this document. 
 

Preparation 
1. IMPORTANT! Make backup copies of your SAS 8.2 PDBs that you want to migrate. 

2. Verify that the release level of SAS IT Resource Management on the server host is compatible with 
SAS IT Charge Management 2.4. The release level of your SAS IT Resource Management should be 
2.7 or later. The release level of the SAS software that your SAS IT Resource Management is installed 
on should be 9.1.3 or later. 

3. Complete the migration of your SAS IT Resource Management Environment from SAS 8.2 to SAS 
9.1.3 following the instructions in the document Migrating Your SAS IT Resource Management 
Environment from SAS 8 to SAS 9. You should have the 8.2 SAS IT Resource Management PDBs 
successfully converted to 9.1.3 SAS IT Resource Management PDBs prior to the migration of your 
SAS IT Charge Management environment.  

4. IMPORTANT! Make backup copies of the 9.1.3 SAS IT Resource Management PDBs.  

5. Make a backup copy of your SAS IT Charge Management 2.3 site definitions. When you invoke SAS 
IT Charge Management 2.3, you are greeted by the Welcome to IT Charge Manager Window. The 
Welcome window displays the Site Definition you have defined. You may find the data set storing 
the site definition at your SAS IT Charge Management 2.3 installation path,  
drive:\[SAS 8.2 Install Path]\cpe\chm\ec\ecsite\ec_sites.sas7bdat. 

To make a backup copy of this data set you need to use either the MS-DOS command or Windows 
Explorer to copy the ec_sites data set to a new location. 

For example, if c:\sas8\cpe\chm\ec\ecsite\ec_sites.sas7bdat is the site definition data 
set for SAS IT Charge Management 2.3, the MS-DOS command for making a backup copy in a new 
location, c:\backup, is: 

COPY c:\sas8\cpe\chm\ec\ecsite\ec_sites.sas7bdat c:\backup 
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You will need to replace the default site definitions data set provided by SAS IT Charge Management 
2.4 with this backup data set. A later section in this document explains the process of recovering 
your site definitions in SAS IT Charge Management 2.4. 

6. Install SAS IT Charge Management 2.4 on SAS 9.1.3 and the most recent maintenance package of 
SAS IT Charge Management 2.4, if any, according to the Installation Instructions for SAS IT Charge 
Management Software 2.4. 
 
Note:  For Windows server, ensure the systems variable, PATH, has the directory where the SAS 

9.1.3 executable precedes the SAS systems of earlier releases if you intend to submit the 
regenerated batch job through the SAS IT Charge Management 2.4. 

 

Your SASUSER Library 
The first time you use SAS IT Charge Management 2.4, it will create a default SASUSER library; however, 
you may have information contained in your SAS IT Charge Management 2.3 SASUSER library that you 
would like to continue to use for Release 2.4. Below are the instructions to copy the contents of the Release 
2.3 SASUSER library to the SAS IT Charge Management 2.4 library.  
 

1. Determine the location of your SAS IT Charge Management 2.3 SASUSER library by invoking the 
SAS IT Charge Management 2.3. Click Exit and select Exit IT Charge Manager only. Select 
View from the pull-down menu. Click Program Editor and type the following statements in the 
Program Editor window:  
 

OPTIONS SOURCE NOTES; 
LIBNAME SASUSER LIST; 
PROC DATASETS DD=SASUSER; 
RUN; 

 
2. Select the Run pull-down menu and click Submit.  

3. Select the View pull-down menu and click Log. You should see statements similar to those below. 
Your SASUSER library is identified by the label Physical Name. In this example, the location of 
the SASUSER library is c:\sas8\cpe\chm\ec\sasuser. 

 
5    OPTIONS SOURCE NOTES; 
6    LIBNAME SASUSER LIST; 
NOTE: Libref=   SASUSER 
      Scope=    Kernel 
      Engine=   V8 
      Physical Name= c:\sas8\cpe\chm\ec\sasuser 
      File Name= c:\sas8\cpe\chm\ec\sasuser 
 
NOTE: PROCEDURE DATASETS used: 
      real time           4:02.34 
      cpu time            0.03 seconds 
 
 
7    PROC DATASETS DD=SASUSER; 
                                       -----Directory----- 
 
                            Libref:        SASUSER 
                            Engine:        V8 
                            Physical Name: c:\sas8\cpe\chm\ec\sasuser 
                            File Name:     c:\sas8\cpe\chm\ec\sasuser 
 
 
                                                File 
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                       #  Name      Memtype     Size  Last Modified 
                       ƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒ 
                       1  PROFILE   CATALOG     9216   27MAY2004:16:36:51 
                       2  PROFILE2  CATALOG    17408   27MAY2004:16:36:51 
                       3  REGSTRY   ITEMSTOR   13312   27MAY2004:16:36:50 
8    RUN; 

 
 

4. Record the physical name of your 8.2 SASUSER library. To exit SAS IT Charge Management 2.3, 
select the File pull-down menu and click Exit.  

5. Invoke SAS IT Charge Management Release 2.4 for SAS 9.1.3. At the Welcome to SAS IT Charge 
Management window, click Exit and select Exit SAS IT Charge Management only.  

6. Select View from the pull-down menu and click Program Editor. Maximize the Program Editor 
window and type the statements shown in Step 1.  

7. Select the Run pull-down menu and click Submit.  

8. Select the View pull-down menu and click Log. Maximize the Log window. You should see the 
location of the SAS IT Charge Management 2.4 SASUSER library indicated by Physical Name. 
Record the physical name of your 9.1.3 SASUSER library.  

9. Select the File pull-down menu and click Exit to leave SAS IT Charge Management 2.4. Now you 
are ready to proceed with the conversion of the SASUSER library.  

10. Invoke SAS 9.1.3 for Windows outside of SAS IT Charge Management 2.4.  
 
Note: Do not invoke SAS 9.1.3 by launching SAS IT Charge Management 2.4. While it is possible 

to exit SAS IT Charge Management only and stay in SAS, the SASUSER library would be 
locked and could not be modified. 

 
11. In the Program Editor, type the following code, edit the location of your SASUSER libraries, and 

submit the edited code.  
 
LIBNAME olduser 'location-of-your-SAS IT Charge Management 2.3-SASUSER-
library' ACCESS=READONLY; 
LIBNAME newuser 'location-of-your-SAS IT Charge Management 2.4-SASUSER-
library'; 
PROC COPY IN=olduser OUT=newuser; 
RUN; 
 

12. Select Log from the View pull-down menu. You should see notes indicating that the contents of the 
old SASUSER have been successfully copied to the new SASUSER library.  

13. Select Exit from the File pull-down menu and exit out of SAS 9.1.3.  
 

Your Site Libraries for SAS IT Charge Management 
These are the instructions for copying the contents of the SAS IT Charge Management 2.3 site libraries to the 
2.4 site libraries. 
 

1. Find the location of your SAS IT Charge Management 2.3 site libraries. You can determine the 
location of these libraries by invoking SAS IT Charge Management 2.3 and selecting a site in the list 
box Select Site to Administrator or Define. You should see the SAS IT Charge Management 
Site Prefix in the Site Properties box below.  
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• z/OS server host 
 

If your SAS IT Charge Management 2.3 site prefix is OLDSITE, you should find the site libraries 
as follows: 
 

o OLDSITE.EC.AUTO  
o OLDSITE.EC.DATA  
o OLDSITE.EC.LIB  
o OLDSITE.EC.SCNTL  
o OLDSITE.EC.SITE  
 

• Windows server host 
 

If your SAS IT Charge Management 2.3 site prefix is c:\oldsite, you should find the site 
libraries as follows: 
 

o c:\oldsite\ec  
o c:\oldsite\ec\auto  
o c:\oldsite\ec\data  
o c:\oldsite\ec\lib  
o c:\oldsite\ec\scntl  
o c:\oldsite\ec\site  
 

2. Decide what you want your SAS IT Charge Management 2.4 site prefix to be.  

3. Allocate space for storing the SAS IT Charge Management 2.4 site libraries.  
 

• z/OS server host 
 

Run IEFBR14 or use ISPF 3.2 to allocate space for the SAS IT Charge Management 2.4 site 
libraries. You will need to allocate the libraries as shown below for each site. You may use the 
same DCB= as the one for the SAS IT Charge Management 2.3 library for allocation. If your SAS 
IT Charge Management 2.4 site prefix is NEWSITE, allocate space for the following:  
 

o NEWSITE.EC.AUTO  
o NEWSITE.EC.DATA  
o NEWSITE.EC.LIB  
o NEWSITE.EC.SCNTL  
o NEWSITE.EC.SITE  
 

• Windows server host 
 

If your SAS IT Charge Management 2.4 site prefix is c:\newsite, create the following 
directories: 
 

o c:\newsite\ec  
o c:\newsite\ec\auto  
o c:\newsite\ec\data  
o c:\newsite\ec\lib  
o c:\newsite\ec\scntl  
o c:\newsite\ec\site  
 

4. Copy the contents of the SAS IT Charge Management 2.3 site libraries to the SAS IT Charge 
Management 2.4 site libraries.  
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• z/OS server host: 
 

A. Start with OLDSITE.EC.DATA and OLDSITE.EC.SITE. These two libraries contain SAS 
objects such as catalogs, data sets, and views. The SAS COPY procedure is used to convert 
the SAS objects from 8.2 to 9.1.3.  

 
Invoke SAS 9.1.3 on the server host and type the following statements in the Program Editor 
window. Edit the location of your SAS IT Charge Management site library and submit the 
edited code for the two libraries respectively. 
 
LIBNAME oldlib 'location-of-your-SAS IT Charge Management 2.3-site-
library' DISP=SHR; 
LIBNAME newlib 'location-of-your-SAS IT Charge Management 2.4-site-
library'; 
PROC COPY IN=oldlib OUT=newlib; 
RUN; 
 
For example, if OLDSITE.EC.SITE is your SAS IT Charge Management site library, the 
edited statements should be: 
 
LIBNAME oldlib 'OLDSITE.EC.SITE' DISP=SHR; 
LIBNAME newlib 'NEWSITE.EC.SITE'; 
PROC COPY IN=oldlib OUT=newlib; 
RUN; 
 
If you check the SAS IT Charge Management 2.4 site libraries at this point, you should see 
SAS 9.1.3 objects, such as catalogs, data sets, and views, converted from the corresponding 
SAS 8.2 objects in the old site libraries. 
 

B. For the rest of the old site libraries, such as OLDSITE.EC.SCNTL and OLDSITE.EC.SLG, 
you need to use ISPF 3.3, IEBCOPY, or IEBGENER in a batch job to copy the contents to 
the new site libraries. (Depending on the data processed into your old site libraries, you may 
find that some of the libraries are empty.)  

 
• Windows server host 
 

A. Start with c:\oldsite\ec\data and c:\oldsite\ec\site. These two libraries 
contain SAS objects such as catalogs, data sets, and views. The SAS COPY procedure is used 
to convert the SAS objects from 8.2 to 9.1.3.  

 
Invoke SAS 9.1.3 on the server host and type the following statements in the Program Editor 
window. Edit the location of your SAS IT Charge Management site library and submit the 
edited code for the two libraries respectively. 
 
For example, if c:\oldsite\ec\site is your SAS IT Charge Management site library, the 
edited statements should be: 
 
LIBNAME oldlib 'c:\oldsite\ec\site' ACCESS=READONLY; 
LIBNAME newlib 'c:\newsite\ec\site'; 
PROC COPY IN=oldlib OUT=newlib; 
RUN; 
 
If you check the SAS IT Charge Management 2.4 site libraries at this point, you should see 
SAS 9.1.3 objects, such as catalogs, data sets, and views, converted from the corresponding 
SAS 8.2 objects in the old site libraries. 
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B. For the rest of the old site libraries, such as c:\oldsite\ec\scntl and 
c:\oldsite\ec\slg, you need to either use the MS-DOS command or Windows Explorer 
to copy the contents to the new site libraries. (Depending on the data processed into your 
old site libraries, you may find that some of the libraries are empty.) 
 
For example, if c:\oldsite\ec\scntl is the site library, the MS-DOS command for 
copying the contents of the old site library to the new site library is: 
 
COPY c:\oldsite\ec\scntl\*.* c:\newsite\ec\scntl 
 

Your PDBs 
In the Preparation section above, you successfully migrated your PDBs from SAS 8.2 to SAS 9.1.3. If you 
check the contents of the new 9.1.3 PDB, you should see nine standard SAS IT Resource Management 
libraries, e.g., detail, day, and so on, in the new PDB library. If in doubt, check with your site's SAS IT 
Resource Management administrator or the person who migrated the SAS IT Resource Management 
environment from SAS 8.2 to SAS 9.1.3. 
 
The following steps describe how to migrate the PDB contents that are SAS IT Charge Management-specific 
from the 8.2 PDB to the new 9.1.3 PDB.  
 

1. Allocate space for storing the SAS IT Charge Management PDB libraries in the new 9.1.3 PDB.  
 

• z/OS server host 
 

Run IEFBR14 or use ISPF 3.2 to allocate space for the SAS IT Charge Management PDB 
libraries. You may use the same DCB= as the one for the SAS IT Charge Management 2.3 library 
for allocation.  
 
If your 9.1.3 PDB is located at NEWPDB, allocate space for the following:  
 

o NEWPDB.EC.CNTL  
o NEWPDB.EC.PDB  
o NEWPDB.EC.SUSP  
o NEWPDB.EC.WORK  

 
• Windows server host 
 

If your 9.1.3 PDB is located at c:\newpdb, create the following directories: 
 

o c:\newpdb\ec      
o c:\newpdb\ec\cntl  
o c:\newpdb\ec\pdb  
o c:\newpdb\ec\susp  
o c:\newpdb\ec\work  

 
2. Copy the contents of the 8.2 PDB libraries to the 9.1.3 PDB.  
 

• z/OS server host: 
 

A. In your 8.2 PDB, for example, OLDPDB, you should have three libraries: 
o OLDPDB.EC.PDB 
o OLDPDB.EC.SUSP 
o OLDPDB.EC.WORK. 
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These libraries contain SAS objects such as catalogs, data sets, and views. You will need to 
run the SAS COPY procedure to convert the SAS objects from 8.2 to 9.1.3. (Depending on 
the data processed into your old PDB libraries, you may find that some of the libraries are 
empty.)  
 
Invoke SAS 9.1.3 on the server host and type the following statements in the Program Editor 
window. Edit the locations of your PDB libraries and submit the edited code for the three 
libraries respectively. 
 
LIBNAME oldpdbec 'location-of-your-SAS IT Charge Management 2.3-
PDB-library' DISP=SHR; 
LIBNAME newpdbec 'location-of-your-SAS IT Charge Management 2.4-
PDB-library'; 
PROC COPY IN=oldpdbec OUT=newpdbec; 
RUN; 
 
If OLDPDB.EC.PDB is your old PDB library, the edited statements should be as follows: 
 
LIBNAME oldpdbec 'OLDPDB.EC.PDB' DISP=SHR; 
LIBNAME newpdbec 'NEWPDB.EC.PDB'; 
PROC COPY IN=oldpdbec OUT=newpdbec; 
RUN; 
 
If you check the 9.1.3 PDB libraries at this point, you should see SAS 9.1.3 objects, such as 
catalogs, data sets, and views, converted from the corresponding SAS 8.2 objects in the old 
PDB libraries. 
 

B. For the rest of the libraries, such as OLDPDB.EC.CNTL, OLDPDB.EC.PLG, and 
OLDPDB.EC.SEQ, you need to use ISPF 3.3, IEBCOPY, or IEBGENER in a batch job to 
copy the contents to their corresponding libraries in the NEWPDB. For instance, use 
ISPF3.3 to copy OLDPDB.EC.CNTL to NEWPDB.EC.CNTL.  

 
• Windows server host 
 

A. In your 8.2 PDB, for example, c:\oldpdb, you should have three libraries: 
o c:\oldpdb\ec\pdb 
o c:\oldpdb\ec\susp 
o c:\oldpdb\ec\work 
 
These libraries contain SAS objects such as catalogs, data sets, and views. You will need to 
run the SAS COPY procedure to convert the SAS objects from 8.2 to 9.1.3. (Depending on 
the data processed into your old PDB libraries, you may find that some of the libraries are 
empty.)  
 
Invoke SAS 9.1.3 on the server host and type the following statements in the Program Editor 
window. Edit the locations of your PDB libraries and submit the edited code for the three 
libraries respectively. 
 
LIBNAME oldpdbec 'location-of-your-SAS IT Charge Management 2.3-
PDB-library' ACCESS=READONLY; 
LIBNAME newpdbec 'location-of-your-SAS IT Charge Management 2.4-
PDB-library'; 
PROC COPY IN=oldpdbec OUT=newpdbec; 
RUN; 
 
If c:\oldpdb\ec\pdb is your old PDB library, the edited statements should be: 
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LIBNAME oldpdbec 'c:\oldpdb\ec\pdb' ACCESS=READONLY; 
LIBNAME newpdbec 'c:\newpdb\ec\pdb'; 
PROC COPY IN=oldpdbec OUT=newpdbec; 
RUN; 
 
If you check the 9.1.3 PDB libraries at this point, you should see SAS 9.1.3 objects, such as 
catalogs, data sets, and views, converted from the corresponding SAS 8.2 objects in the old 
PDB libraries. 
 

B. For the rest of the libraries, such as c:\oldpdb\ec\cntl, c:\oldpdb\ec\plg, and 
c:\oldpdb\ec\seq.sas, you need to use either the MS-DOS command or Windows 
Explorer to copy the contents to the new PDB libraries.  

 
For example, if c:\oldpdb\ec\cntl is the PDB library, the MS-DOS command for 
copying the contents of 8.2 PDB library to the new PDB library is: 
 
COPY c:\oldpdb\ec\cntl\*.* c:\newpdb\ec\cntl 
 

Your Account View Extract File 
You may skip this section if you do not have the Account View extract file of SAS IT Charge Management 2.3. 
 
The following are instructions for how to migrate your Account View extract file from SAS IT Charge 
Management 2.3 to 2.4: 
 

1. Find the location of the Account View extract file that you downloaded from SAS IT Charge 
Management 2.3.  

2. Choose a location on your computer where you want to store the SAS IT Charge Management 2.4 
Account View extract file that is being migrated from 2.3.  

3. Convert the Account View extract file from SAS IT Charge Management 2.3 to 2.4.  
 

Invoke SAS 9.1.3 of Windows and type the following statements in the Program Editor window. Edit 
the directories where your Account View extract files are located and submit the edited code. 
 
LIBNAME oldav 'directory-where-your-SAS IT Charge Management 2.3 Account 
View-extract-file-is-located' ACCESS=READONLY; 
LIBNAME newav 'directory-where-your-SAS IT Charge Management 2.4 Account 
View-extract-file-is-located'; 
PROC COPY IN=oldav OUT=newav; 
RUN; 
 

Launch SAS IT Charge Management Software, Release 2.4 
1. Before you invoke SAS IT Charge Management 2.4, you need to replace the default site definition 

provided by SAS IT Charge Management 2.4 with your own site definitions. The default site 
definition may be found at  
drive:\[SAS 9.1.3 Install Path]\cpe\chm\ec\ecsite\ec_sites.sas7bdat. 
 
Obtain the directory name of the backup ec_sites data set that you made in the Preparation 
section. Invoke SAS 9.1.3 on Windows, type the statements below in the Program Editor window, 
edit them, and submit the edited code.  
 
LIBNAME olddef 'directory-which contains-the-backup-ec_sites-table' 
ACCESS=READONLY; 
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LIBNAME newdef 'drive:\[SAS 9.1.3 Install Path]\cpe\chm\ec\ecsite'; 
PROC COPY IN=olddef OUT=newdef; 
   SELECT EC_SITES; 
RUN; 
 

2. Invoke SAS IT Charge Management Release 2.4 for SAS 9.1.3. You should see your site definitions of 
SAS IT Charge Management 2.3 displayed at the Welcome to SAS IT Charge Management window.  

3. Select a site and modify the text fields, such as SAS IT Charge Management Site Prefix, displayed in 
the Site Properties box. Check with your SAS IT Resource Management administrator if you need 
assistance for the following modifications.  

 
• Change the SAS IT Charge Management Site Prefix to refer to the same site prefix that you 

decided earlier at step 2 in the section called Your Site Libraries for SAS IT Charge Management 
in this document.  

• Modify the SAS IT Resource Management SITELIB to reflect the SAS 9.1.3 SAS IT Resource 
Management site library.  

• Verify that the logon script file, if any, is valid for invoking SAS 9.1.3 on the server.  
• If your site resides in a local Windows environment, you need to change the CPUSROPT data set 

to the one for SAS 9.1.3 SAS IT Resource Management.  
 

4. Click the Save Properties button to save the information in the Site Properties box.  

5. Click Open to open the site.  

6. Select the Site Administration tab and click Manage Site Defaults and Accounting 
Calendar. Click Execution Control on the right.  

• If the site is on a z/OS server host, modify the JCL parameters to correctly reflect the settings for 
your SAS 9.1.3 system.  

• If the site is on a Windows server host, verify the Host SAS name. Click OK to save the 
modifications.  

7. Under the Site Administration tab, click Manage Site Defaults and Accounting Calendar. 
Click Calendar Definitions on the right.  
Verify the calendar definitions for this site and click OK. This will update the definitions and upload 
them to the server. This step is required to ensure the correct regeneration of the calendar 
definitions through SAS IT Charge Management 2.4.  

8. Click the PDB selection button in the upper-left corner. Click the 9.1.3 PDB that has been 
converted from the 8.2 PDB following the process in the Your PDB section on the selection list. 
Select the Manage PDBs tab. Select Define Rate Models, Charges, and Assignments.  

• If your site is on a z/OS server host, click Execution Control on the right. Verify the JCL 
statements and click OK.  

9. Click Data Base Definition on the right.  

10. Select the item called Apply Selections and Edit, Manual Submit. Click OK. You should see 
the window called Edit and Submit CPDDUTL Batch Job.  

11. Verify the code of the batch job and make modifications if necessary.  

12. Click the Submit pull-down menu and select Save, Submit, and End to run the Data Base 
Definition job (CPDDUTL), which updates the dictionary.  

• For z/OS servers, you must disconnect from the site in SAS IT Charge Management 2.4 for the 
Data Base Definition job to complete. SAS IT Charge Management 2.4 automatically detects this 
and presents a window to facilitate the disconnection as soon as you submit the job. 
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13. To ensure that your batch jobs refer to the appropriate data sets in your new PDB and site libraries 
after the migration, regenerate the batch job code through the SAS IT Charge Management 2.4 
graphical user interface.  
 
• For Consolidation, follow these steps: 
 

A. Select the Operation tab in the SAS IT Charge Management 2.4 main window. Select 
Consolidate Data.  

B. Select an invoice period and click Apply Selections and Edit, Manual Submit. Click 
OK. The Edit and Submit CONSOL Batch Job window should open. 

C. Verify the code of the batch job and make any necessary modifications.  
D. Save the batch job. If appropriate, you may submit the job via the Submit pull-down menu 

at this time.  
E. Repeat steps A through D for other invoice periods.  
 

• For To-Date Consolidation, follow these steps: 
 

A. Select Reports tab in the SAS IT Charge Management 2.4 main window. Select To-Date 
Consolidation.  

B. Select an invoice period and click Apply Selections and Edit, Manual Submit. Click 
OK. The Edit and Submit CONSOLz Batch Job window should open. 

C. Verify the code of the batch job and make any necessary modifications.  
D. Save the batch job. If appropriate, you may submit the job via the Submit pull-down menu 

at this time.  
E. Repeat steps A through D for other invoice periods.  

 
• For Standard Invoices, follow these steps: 
 

A. Select Operation tab in the SAS IT Charge Management 2.4 main window. Select Run 
Standard Invoices.  

B. Select an invoice period and click Apply Selections and Edit, Manual Submit. Click 
OK. The Edit and Submit SCHRPT Batch Job window should open. 

C. Verify the code of the batch job and make any necessary modifications.  
D. Save the batch job. If appropriate, you may submit the job via the Submit pull-down menu 

at this time.  
E. Repeat steps A through D for other invoice periods.  

 
• For To-Date Reporting, follow these steps: 
 

A. Select Reports tab in the SAS IT Charge Management 2.4 main window. Select To-Date 
Reporting.  

B. Select an invoice period and click Apply Selections and Edit, Manual Submit. Click 
OK. The Edit and Submit todate Batch Job window should open.  

C. Verify the code of the batch job and make any necessary modifications.  
D. Save the batch job. If appropriate, you may submit the job via the Submit pull-down menu 

at this time.  
E. Repeat steps A through D for other invoice periods. 

 
• For Site Configuration,  
 

A. Select Reports tab in the SAS IT Charge Management 2.4 main window. Select Site 
Configuration.  

B. Click Apply Selections and Edit, Manual Submit. Click OK. The Edit and Submit 
CONRPT Batch Job window should open.  

C. Verify the code of the batch job and make any necessary modifications.  
D. Save the batch job. If appropriate, you may submit the job via the Submit pull-down menu 

at this time.  
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14. Repeat steps 5 through 13 for each PDB of the selected site. 
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